N

MICROCHIP

MCP3425 SOT23-6
Evaluation Board
User’s Guide

© 2009 Microchip Technology Inc.

88888888



Note the following details of the code protection feature on Microchip devices:
. Microchip products meet the specification contained in their particular Microchip Data Sheet.

. Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the
intended manner and under normal conditions.

. There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our
knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data
Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

. Microchip is willing to work with the customer who is concerned about the integrity of their code.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not
mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our
products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts
allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device
applications and the like is provided only for your convenience
and may be superseded by updates. It is your responsibility to
ensure that your application meets with your specifications.
MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR
IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION,
INCLUDING BUT NOT LIMITED TO ITS CONDITION,
QUALITY, PERFORMANCE, MERCHANTABILITY OR
FITNESS FOR PURPOSE. Microchip disclaims all liability
arising from this information and its use. Use of Microchip
devices in life support and/or safety applications is entirely at
the buyer’s risk, and the buyer agrees to defend, indemnify and
hold harmless Microchip from any and all damages, claims,
suits, or expenses resulting from such use. No licenses are
conveyed, implicity or otherwise, under any Microchip
intellectual property rights.

QUALITY MANAGEMENT SYSTEM
CERTIFIED BY DNV

= I1S0/TS 16949:2002 —

Trademarks

The Microchip name and logo, the Microchip logo, Accuron,
dsPIC, KEeLOQ, KEeLOQ logo, MPLAB, PIC, PICmicro,
PICSTART, rfPIC, SmartShunt and UNI/O are registered
trademarks of Microchip Technology Incorporated in the
U.S.A. and other countries.

FilterLab, Linear Active Thermistor, MXDEV, MXLAB,
SEEVAL, SmartSensor and The Embedded Control Solutions
Company are registered trademarks of Microchip Technology
Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, CodeGuard,
dsPICDEM, dsPICDEM.net, dsPICworks, dsSPEAK, ECAN,
ECONOMONITOR, FanSense, In-Circuit Serial
Programming, ICSP, ICEPIC, Mindi, MiWi, MPASM, MPLAB
Certified logo, MPLIB, MPLINK, mTouch, PICkit, PICDEM,
PICDEM.net, PICtail, PIC3? logo, PowerCal, Powerlinfo,
PowerMate, PowerTool, REAL ICE, rfLAB, Select Mode, Total
Endurance, WiperLock and ZENA are trademarks of
Microchip Technology Incorporated in the U.S.A. and other
countries.

SQTP is a service mark of Microchip Technology Incorporated
in the U.S.A.

All other trademarks mentioned herein are property of their
respective companies.

© 2009, Microchip Technology Incorporated, Printed in the
U.S.A., All Rights Reserved.

Q Printed on recycled paper.

Microchip received ISO/TS-16949:2002 certification for its worldwide
headquarters, design and wafer fabrication facilities in Chandler and
Tempe, Arizona; Gresham, Oregon and design centers in California
and India. The Company’s quality system processes and procedures
are for its PIC® MCUs and dsPIC® DSCs, KEELOQ® code hopping
devices, Serial EEPROMSs, microperipherals, nonvolatile memory and
analog products. In addition, Microchip’s quality system for the design
and manufacture of development systems is ISO 9001:2000 certified.

DS51787A-page ii

© 2009 Microchip Technology Inc.



MCP3425 SOT23-6 EVALUATION
MICROCHIP BOARD USER'’S GUIDE

Table of Contents

= = T = PRSP 1
INEFOAUCTION. ... s 1
DOCUMENT LAYOUL ...ttt ettt ettt e e e e e e e eeanba e e e e e aeeeeneneas 1
Conventions Used in thiS GUIAE ..........c.eeiiiiiiiiiiiiii e, 2
Recommended REAAING.......ccciviiiiiiiii e e e e e e e e e e e e e eennees 3
The MiIcroChip WED SIte ........uuuiiiiiiiiiiiiiiiiiii e eees e e seeeeeeeeeees 3
CUSTOMET SUPPON ..ttt ettt e et et e e et e e e e e e et e eeeeeeeeeeeeee et eeeeeeeeeeeeeees 3
Document ReVISION HISTOIY .......ccoiiiiiiiiiiiiiie et 4

Chapter 1. Quick Start Instructions
0 1 o o 18 Tox 1 o] o SRR 5
1.2 Description of the MCP3425 SOT23-6 Evaluation Board ..................coeeeennn. 5
1.3 Getting Started with PICkit™ Serial Analyzer ..........ccccooiiiiii, 7

Appendix A. Schematic and Layouts
AL INITOAUCTION it e e et r e e e e e s e r e e e e e e e e aaa 23
A.2 Board — SChematiC .......coooeiii e 24
A.3Board — TOP LAY ..coooiiiee e 25
A.4 Board — Top Metal Layer .......ccoooiiioiiiieeee e e 26
A.5 Board — BOtOM LaYer ....cccccoiiiiiii e ann e 27

Appendix B. Bill Of Materials (BOM)

Worldwide Sales and SErVICE .....oooeeeiiiiiiiiiiiiiiie et e e e e e e e e eeeeeeennnnn 30

© 2009 Microchip Technology Inc. DS51787A-page iii



MCP3425 SOT23-6 Evaluation Board User’s Guide

NOTES:

DS51787A-page iv © 2009 Microchip Technology Inc.



MCP3425 SOT23-6 EVALUATION

MICROCHIP BOARD USER'’S GUIDE

Preface

NOTICE TO CUSTOMERS

document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX" is the document number and “A” is the revision level of the

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP3425 SOT23-6 Evaluation Board. Items discussed in this chapter include:

Document Layout

Conventions Used in this Guide
Recommended Reading

The Microchip Web Site
Customer Support

Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP3425 SOT23-6 Evaluation Board as a
development tool to emulate and debug firmware on a target board. The manual layout
is as follows:

Chapter 1. “Quick Start Instructions” — this chapter provides an overview of the
MCP3425 SOT23-6 Evaluation Board and instructions on how to program the
DAC register and EEPROM of the MCP4725 device.

Appendix A. “Schematic and Layouts” — shows the schematic and layout
diagrams for the MCP3425 SOT23-6 Evaluation Board.

Appendix B. “Bill Of Materials (BOM)” — lists the parts used to build the
MCP3425 SOT23-6 Evaluation Board.

© 2009 Microchip Technology Inc. DS51787A-page 1
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

dialog

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl1l8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants OXFF, “A”

Italic Courier New

A variable argument

file.o, where File can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file
[options]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var_name [,
var_name...]

Represents code supplied by
user

void main (void)
{ ...
}

DS51787A-page 2
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RECOMMENDED READING

This user's guide describes how to use the MCP3425 SOT23-6 Evaluation Board with
the PICKit Serial Analyzer. The following Microchip documents are available and rec-
ommended as supplemental reference resources.

PICKit™ Serial Analyzer User’s Guide, DS51647

Consult this document for instructions on how to use the PICkit Serial Analyzer hardware
and software.

MCP3425 Data Sheet, “16 bit Analog-to-Digital Converter with 1°C Interface and
On-Board Reference”, DS22072

This data sheet provides detailed information regarding the MCP3425 product.

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

« Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

 Local Sales Office

* Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer

(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

© 2009 Microchip Technology Inc. DS51787A-page 3
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DOCUMENT REVISION HISTORY
Revision A (January 2009)

« |nitial Release of this Document.
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Chapter 1. Quick Start Instructions

1.1 INTRODUCTION

The following sections provide an overview of the MCP3425 SOT23-6 Evaluation
Board and demonstrate how to use it with the PICkit™ Serial Analyzer
(P/N: DV164122).

The following topics are covered:

 Description of the MCP3425 SOT23-6 Evaluation Board

« Using MCP3425 SOT23-6 Evaluation Board with the PICKit Serial Analyzer to
evaluate the MCP3425 device.

1.2 DESCRIPTION OF THE MCP3425 SOT23-6 EVALUATION BOARD

The MCP3425 SOT23-6 Evaluation Board (P/N MCP3425EV) contains a MCP3425
16-bit Delta-Sigma Analog-to-Digital Converter (ADC). The MCP3425 is an 16-bit
single channel ADC device with various options. The MCP3425 SOT23-6 Evaluation
Board has analog input connection pads and Vpp, SDA, and SCL test pads. The user
can connect any sensor input signal to this evaluation board and test the ADC
conversion results. The PICkit Serial Analyzer’s PC graphic user interface (GUI)
provides the user’s interface for configuration register bits of the MCP3425 and
displays the ADC conversion values. The PICkit Serial Analyzer links between the GUI
and the MCP3425 SOT23-6 Evaluation Board and provides the I°C communication to
the MCP3425 SOT23-6 Evaluation Board. The user also can use this MCP3425
SOT23-6 Evaluation Board without the PICkit Serial Analyzer by providing the 1°C
communication signal to the SDA and SCL test pads on the board.

This evaluation board has the following interfaces:

« PICKkit Serial Analyzer (P/N: DV164122) for writing configuration register bits and
reading the conversion data.

Note: The user can use this board without the PICkit Serial Analyzer as long as
the Vpp, SCL, and SDA are provided to the board. This evaluation board
does not include MCU.

The user can monitor the 1°C communications by connecting an oscilloscope to the
SDA and SCL test pads. Refer to Appendix A. “Schematic and Layouts”.

© 2009 Microchip Technology Inc. DS51787A-page 5



MCP3425 SOT23-6 Evaluation Board User’s Guide

1.2.1 I2C Address Bits

The 12C device code and address bits of the MCP3425 device in this evaluation board
are pre-programmed at factory (Code: 1101000).

Power o "’" A4 MCP3425
#5.  zgsssg SOT23-6
D1 RS ) Evol boord

« JP1

102-00191

FIGURE 1-1: Front and Back Views of the MCP3425 SOT23-6 Evaluation
Board.

DS51787A-page 6 © 2009 Microchip Technology Inc.
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1.3 GETTING STARTED WITH PICKIT™ SERIAL ANALYZER

Figure 1-1 shows the MCP3425 SOT23-6 Evaluation Board, while Figure 1-2 shows
the evaluation board and the PICkit Serial Analyzer connection.

The following instructions show how to use them together:

1. Connect the MCP3425 SOT23-6 Evaluation Board’s J1 pin socket to the PICKit
Serial Analyzer, as shown in Figure 1-2.

2. Connect oscilloscope probes to SCL and SDA test pins (optional).

3. Vpp selection: You can use the Vpp from the PICKit Serial Analyzer or your own
external Vpp. You can select the Vpp path using the JP1 connector:

(a) Connect JP1, if using Vpp from PICKkit Serial Analyzer.
(b) Disconnect JP1 and apply Vpp at the Vpp pad, if you are using external Vpp.

Note: If you are using external Vpp, connect the external Vpp at Vpp pad. I

4. Connect Vpp, if external Vpp is used.

Note: Do not connect Vpp if you are using the Vpp from the PICkit Serial
Analyzer. The PICkit Serial Analyzer provides the Vpp automatically if it is
connected to the PC.

5. LED D1 is turned on when Vpp is applied.

Note: Ifthe Vpp is provided from the PICkit Serial Analyzer, then the LED may not
be turned on until you execute a command. See Section 1.3.2.1 “Creating
a Script File for Configuration Byte Writing” for executing the 1°C
command.

6. Connecting analog inputs: If you need to measure single-ended input, connect
the unused pin (for example, V|y-) to Vgs.

7. Use the PICkit Serial Analyzer PC GUI to send I°C write and read commands.
See Section 1.3.2.1 “Creating a Script File for Configuration Byte Writing”

8. Execute the PICkit Serial Analyzer Script file and obtain the ADC conversion
results. The conversion results appear on the PICkit Serial Analyzer PC GUI. You
can also observe the conversion results using the oscilloscope.

CAUTION

The analog input pin has ESD diodes. Certain input conditions can damage the
device. Please pay attention to the following conditions:

(a) Do not apply input greater than the input range specified by the MCP3425
data sheet.

(b) Apply input signal after the Vpp is powered-up.

© 2009 Microchip Technology Inc. DS51787A-page 7
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Personal Computer

v

bl

USB Cable

Connected between the
PICKit Serial analyzer
and Personal Computer

PICKit Serial Analyzer

Sensor Input
Connectors

MCP3425 Evaluation Board

FIGURE 1-2: MCP3425 SOT23-6 Evaluation Board with the PICkit™ Serial Analyzer.

131 PICkit™ Serial Analyzer PC Software Set-Up for the MCP3425
Evaluation Board

The following steps describe how to set up and use the PICkit Serial Analyzer PC
Graphic User Interface (GUI) to write the configuration bits of the MCP3425 on the
MCP3425 SOT23-6 Evaluation Board and read the ADC conversion results.

1. Install the PICkit Serial Analyzer software onto your personal computer (PC).
2. Connect the USB cable between the PICkit Serial Analyzer and your PC.

3. Runthe PICkit Serial PC Software; the following graphic user interface (GUI) will
appear. Click the Next button and follow the instructions.

DS51787A-page 8 © 2009 Microchip Technology Inc.
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Configuration Wizard E

Welcome To The
PICkit Serial Analyzer
= Configuration Wizard

U= The following steps will guide you through the

E zetup of the PICK Senal Analyzer.

| Mext = | Cancel

FIGURE 1-3: PICkit Serial Analyzer Configuration Wizard Welcome Window.

4. Select the Communication Mode type: 12C Master, and click the Next button.

Configuration Wizard H

Communication Mode - Page 1 of 4

Chooze which mode of communication you wizh to uze.

* |2C Master
" SPI Master
7 USART fsync
" USART Sync Master
< Back Mest > Cancel
FIGURE 1-4: Step 1 - Communication Mode Selection.

© 2009 Microchip Technology Inc. DS51787A-page 9
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5. Select 100 kHz or 400 kHz. Either one will be fine. Click the Next button.

Configuration Wizard E

Communication Speed - Page 2 of 4

Select your 12C communication zpeed

Communication zpeed may alzo be
" 100kHz  adjusted by using the 'Configure
s tMode' page from the 'PICK Sernal
400 kHz :
Analyzer menu dropdown after
completing the Configuration
“izard.

< Back Memnt » Cancel

FIGURE 1-5: Step 2 - 1°C Communication Speed Window.

Note: The MCP3425 device supports the 12C bus data rate up to 3.4 MHz, but the
current version of the PICKkit Serial Analyzer supports the 12C bus data rate

up to 400 kHz only.

6. Select No on Enable Pull-ups and click the Next button.

Note: The MCP3425 SOT23-6 Evaluation Board has its own pull-up resistors. I

Configuration Wizard E

Device Pullups - Page 3 of 4

Do you need to enable pullups for your device?

Enable Pullups
" Yez ™ Mo

< Back Mest » Cancel

FIGURE 1-6: Step 3 - Device Pullups Window.

DS51787A-page 10 © 2009 Microchip Technology Inc.
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7. Selectthe Vpp voltage of the MCP3425 SOT23-6 Evaluation Board and click the_
Next button.

Case 1: When you use Vpp from the PICkit Serial Analyzer:

If you choose PICKit Serial will power my device and 5 Volt as shown below,
the MCP3425 SOT23-6 Evaluation Board is powered by the 5V DC from the
PICKit Serial Analyzer through the JP1 jumper. In this case, make sure that the
JP1 jumper on the MCP3425 SOT23-6 Evaluation Board is connected.

Case 2: When you use your own Vpp:

You can also provide your own Vpp voltage by applying a Vpp voltage at Vpp test
point on the board. In this case, make sure that the JP1 jumper is disconnected.

Configuration Wizard E

Yoltage Source - Page 4 of 4
Does PICKR Senial need to power your device?

Yoltage

v FICkit Serial wil

power my device . o
IF PICKit Serial will poweer wour

f# 5%l device, select the checkbox to
™ Other the left, then determine pour
voltage.

g0

¢ Back Memt > Cancel

FIGURE 1-7: Step 4 - Voltage Source Selection Window.

© 2009 Microchip Technology Inc. DS51787A-page 11
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8. Click the OK button. You have made all of the PICkit Serial Analyzer Configura-
tion Set-ups. You are now ready to program the MCP3425 SOT23-6 Evaluation

Board using the PICkit Serial Analyzer.

Configuration Wizard E

You're Done!

Presz '0FK' to complete the Configuration ‘wizard.

[ Do not show this wizard on startup again

“wiizard may be acceszzed anytime from
menu dropdown PICK Senal Analpzer -»
Run Configuration ‘wizard.

Ok

FIGURE 1-8: Configuration Wizard - Finishing Step.

DS51787A-page 12 © 2009 Microchip Technology Inc.
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1.3.2 Creating Script Files

In order to make a communication between the PICkit Serial Analyzer and the
MCP3425 SOT23-6 Evaluation Board, a script file is needed. The following procedure
shows how to create script files and how to use them.

» Select Communication -> Script -> Script Builder.

1 P|Ckit Serial - 12 Master Mode E
Cammunications | PICKE Serial Analyzer  DemaBoards  Lser Defined Templates  View  Window  Help

Basic Operations sic Operations | Reset l2LM

Sarpt Srip Buider I stos

- [ Update
Seript Execute I Executive Emar

W Communicztion Eror
I I2€ Eror

1 | j
Transactions EitRate: 100.0kHz

Source Waltage: 4.4
[rata Line Waltage: 484
Clock Line oltage: 4.7

File » Edit v Clear

02/13/2007 4:59:14 MM

Welcome to PICkit Serial version 2.0.1.0

Found PICkits.d11 - Ver: 1,3.0.0

Found PICkit Serial Analyzer - FW Ver: 0x0108
1158 cantral block updated with preference data.

Basic WView Set,

FIGURE 1-9: Creating a Script File with Script Builder.

© 2009 Microchip Technology Inc. DS51787A-page 13
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1.3.2.1 CREATING A SCRIPT FILE FOR CONFIGURATION BYTE WRITING

1. Click on WriteBlockAddrA8 in “Example 1°C Scripts” column.

 This will result in filling in the spaces under Script Detail column.
Now you can modify the Script Detail column parameters by clicking with the
right mouse button.

Modifying the Script Details parameters:

1. Under the Script Detail box, select the item in the parameter box.

2. Right click the mouse button and an option box appears to the right of your
selection. This gives you the options that are available for the parameter
selected.

3. Select the desired options (delete or insert the parameter box).

4. Keep the parameters in the same order as shown in the image below:

il PICkit Serial - 12C Master Moda

Comrunications  PICkit Serial Anakezer  Demo Boards  User Defned Templates Yiew  Window  Hep

Vigw: Basic | Communications: Basic Operations | Reset

» ||

Script Builder -
Example 12C Scripls Scrpt Detal LJzer |2C Scripts
Scipt Name Readdddiad I— 1=t MCI3425 ‘A7 1Bt
|2ESTAART MCP2425_Read_000

WMCP3475 W1 16bi \Wiedddiss
St WiteBlockbddia s [20WRTENT
i FeadBlbckiddis Inz—
Save Script =
/—> Do x
98 =
1. To change value:
Clej o Click this box and |2C5TOP —
type a new value. I—"
2. To delete or insert box: .
Del i o Choose the box and right x
_ click the mouse button for
options available. x
Shq 3. Make sure the listed I—"‘
parameters in “Script Detail”
are in the exact order =

as shown here.

Execute Script |

FIGURE 1-10: Modifying Parameters in the Script Builder Window.

DS51787A-page 14
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5. Change the parameter value.

Script Detail

[2CSTART *
[2CWRTBYT |«

02 | - > This means there are two bytes to send

Do | e > 1st Write Byte: Address byte with W/R bit = 1101-0000
98 | - > 2nd Write Byte: Configuration byte = 1001-1000
[2CSTOP *

Note: All 6 parameters above must be listed in the same order as shown here.
The parameters above with * are not modifiable. Address bits
(A2, Al, AO) = (0,0,0) for this evaluation board. See the MCP3425 Data
Sheet for more information on address bit selection.

© 2009 Microchip Technology Inc. DS51787A-page 15
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o PICkit Serial - 12C Master Mode

Communicabions  PTCkE Serial Analyzer  Demo Boards  User Defined Templates Wew  Window  Help

Yiews: Basic | Communications: Basic Operations | Reset

Script Builder - x

Exarnple [2C Scripts Scrpt Detai Llzer [2C Scrpts
Script Mame Readdddrad =1 MCF3425 "1 16Ei
Mca4zs wi teor | | DN I2CSTART MCP3425_Read 000
=S wiiiteBloc kaddids [12C/RTEYT

ReadBlockAadddd

Sawve Script | |':'2 *

2 Bytes to send

| Execute Script |

aa x
Clear Script | I2E5TDF‘ _
=
Del Uzer Scrpts | =
| x
S5how Amay | Configuration Byte | -
(98) | ”
| x
| x

ar

5:41:19 PM Sent script from Script Builder page, 9 bytes:

(21w _J[0z2][eo]les]lP_]
(s-1lr-]

Note the 98 in the configuration byte selects the following options:
- Conversion Mode: Continuous Conversion

- Bit Resolution: 16 bits
- Gain Selection: 1x

FIGURE 1-11: Script File Example for the I2C Write Command.

DS51787A-page 16 © 2009 Microchip Technology Inc.
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1.3.2.2 SAVING THE SCRIPT FILE AND PROGRAMMING THE
CONFIGURATION REGISTER

1. Change the 2nd and 3rd data bytes you want in the Script Detail.

2. Typeinany script name (i.e., MCP3425_ Wr_16Bit) in the space below the Script
Name menu.

3. Click Save Script button.
4. Click Execute Script button.

Note: At this point, the PICkit Serial transmits the 1°C Write command to the
MCP3425 device. The saved file name will appear in Users 12C Scripts
column, and can be re-used any time by selecting the file name.

5. You can also see the SCL and SDA waveforms using the oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and recheck the parameter values in
the order of parameters under the “Script Detail” column. Try again until the
“Busy” LED goes OFF immediately after executing the write command.

Zoom-in

Write Command with Address bits Configuration Bits

FIGURE 1-12: I2C Write Command Waveforms for the MCP3425.
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1.3.3 Reading the Conversion Data using the PICKkit Serial Analyzer

You can read back the conversion data with the following steps.

1.3.3.1 CREATING A SCRIPT FILE TO READ CONVERSION DATA

1. Click on ReadAddrA8 in “Example 12C Scripts” column.

* This will result in filling in the spaces under the Script Detail column.
Now you can modify the parameter boxes (delete or insert) in the Script Detail
column with options. The list of options will appear if you click the right mouse but-
ton at the parameter box. You can delete the parameter box or add a new one.

« Make sure the “Script Detail” parameters are listed in order, as following:

Script Detail

[2CSTART
I2CWRTBYT | *
or |- > This means there is one byte to send for address

D1 | - > Address byte with W/R bit = 1101-0001
[2CRDBYTNLB *

4 |- > 4 bytes to read

[2CSTOP *

Note: All 7 parameters above must be listed in the same order as shown here.
The parameters above with * are not modifiable. Address bits (A2, A1, AO)
= (0,0,0) for the MCP3425 SOT23-6 Evaluation Board. See the MCP3425
Data Sheet for more information on address bit selections.
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id PICkit Serial - 12C Master Mode

Communications  PICkit Serial Anakyzer  Demo Boards  User Defined Templakes  Wiew  Window  Help

YWiew; Basic | Communications, Gasic Operations | Resst

Script Builder = ]

Example 12C Scriphs Soript Detail Iz [2C Scripts

5 cript Mame F eaddddras |I2E5T aAT =] -II'I

MCOP3425_Read_000 | | WiteAddidS ACP2425 Read 000
i wrikeBlockaddid |I2CWRTBYT
i R eadBlockaddiad | o
Save Script | *
£ Seri | D1 x
xecute S cript
Clear Script | |4 x
l2CSTOP

Requesting
4 Bytes

Del User Scrpks |

Show Ammay |

FIGURE 1-13: Script File Sample to Read Conversion Data.
2. Type in any script name (i.e., MCP3425_Read) in the space below the Script
Name menu.
3. Click Save Script button.
4. Click Execute Script button.

Note: At this point, the PICKit Serial transmits the 1°C Read Command to the
MCP3425 device. The saved file name will appear in Users 12C Scripts
column, and can be re-used any time by selecting the file name.

5. You can also see the SCL and SDA waveforms using the oscilloscope.

Note: When you click on the “Execute Script” menu, the “Busy” LED on the PICKkit
Serial Analyzer will momentarily turn on and then turn off. If the LED
remains ON, a communications problem has occurred. Remove the PICkit
Serial Analyzer from your computer and recheck the parameter values in
the order of parameters under the “Script Detail” column. Try again until the
“Busy” LED goes OFF immediately after executing the read command.
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il PICkit Serial - 12C Master Mode

Communications  PICkiE Serial snalyzer  Demo Boards  User Defined Templates  Wiew  Window  Help

Wiew ! Basic | Communications: Basic Operations | Reset

Seript Builder - x

Ewnample 120 Soripts Sript D etail zer 20 Scripts
Secnpt Mame R ead® dddd 2l FACP3425 ' 1Ehit
[MCP3425_Read ooo | | Wiritedddas Jl2CSTART MCP3425 Read 000
== WiiteBlockaddit® [|2Cw RTEYT
i ReadBlockaddndd |IZI‘I

Save Script | =

(D1 x
Execute Script | |I2EF|DE=YTHLE=

Clear Script | [4 =

[l2csTOP
Del User Scrpts | | £3

| .,

Show Auray | | -
| =
| =
| =

£:16:13 FM Sent script from Script Builder page, 10
bytecs

[=_] 0w _][01][01] [RM] [04] [F'j/éeading Conversior)
[s_1T1F][s01C18]0eaT P ] Data

A

L 4th Byte: Repeated Byte for Configuration byte
(note that RDY bit returned to “1” after 4th byte)

3rd byte: Configuration Byte (note that RDYbit is “0”)

2nd byte: Data Byte

— 1st byte: Data Byte

Results:

Output code: 1F50 in hex ( = 8016 in decimal)
Output Voltage: 8016 x 62.5 pV (LSB) = 0.501V
Note:

*1 LSB for 16 bit = 62.6 pV
* Input at CH1 = 0.501V

FIGURE 1-14: Reading Conversion Results: Note that the Input = 0.501V is applied at Ch.1. The
reading indicates the measured value is 0.501V. See Figure 1-15 for waveforms.
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Quick Start Instructions

=

Zoom-in

-

Tt e i e ferefeee

mEm e e

A A

Data Bytes = 0101AD (hex)

(a) Read command and outputs. The 3 data bytes are zoomed in for better clarity.

-

()

3rd Byte 4th Byte

i ! feeeefe

CEET I -

/V Y .
LA

Configuration Byte and Repeated Configuration Byte

(b) Read command and outputs. The last two data bytes are zoomed in for better clarity.

FIGURE 1-15: Read Command and Data on I°C bus. Note the RDY bit in 3rd byte is “0”. This means
the conversion data just read is the latest conversion data. After the RDY bit is read out at the 3rd byte, the
RDY bit becomes now “1” in the 4th byte (repeated byte). This means the device is now in the process of a
new conversion and the latest conversion result is not ready yet.
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@ MCP3425 SOT23-6 EVALUATION
MICROCHIP BOARD USER’S GUIDE

Appendix A. Schematic and Layouts

A.1 INTRODUCTION
This appendix contains the following schematics and layouts for the MCP3425
SOT23-6 Evaluation Board:
» Board — Schematic
» Board — Top Layer
« Board — Top Metal Layer
« Board — Bottom Layer
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A.3 BOARD -TOP LAYER
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A.4 BOARD - TOP METAL LAYER

Power

MCP3425
S0T23-6
Eval board
102—00191

DS51787A-page 26 © 2009 Microchip Technology Inc.



Schematic and Layouts

A5 BOARD-BOTTOM LAYER

104-00191—R1
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MCP3425 EVALUATION BOARD
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MICROCHIP

Appendix B. Bill Of Materials (BOM)

TABLE B-1: BILL OF MATERIALS
Qty Reference Description Manufacturer Part Number
1 C1l CAP .1UF 25V CERAMIC X7R Panasonic® - ECG ECJ-2VB1E104K
0805
1 Cc2 CAP CERAMIC 10UF 6.3V X5R Panasonic - ECG ECJ-2FB0J106K
0805
1 D1 LED RED ORANGE CLEAR 0805 |LITE-ON INC LTST-C170EKT
SMD
1 Ji CONN HEADER 6POS .100 R/A Molex/Waldom Electronics 22-28-8062
GOLD Corp
1 PCB RoHS Compliant Bare PCB, — 104-00191
MCP3425 SOT23-6 Eval Board
2 R1, R3 RES 4.99K OHM 1/8W 1% 0805 Panasonic - ECG ERJ-6ENF4991V
SMD
R2, R4 DO NOT POPULATE — —
R5 RES 470 OHM 1/8W 5% 0805 SMD | Panasonic - ECG ERJ-6GEYJ471V
Ul 16-Bit Analog-to-Digital Converter | Microchip Technology Inc. MCP3425A0T-E/CH
with 12C Interface and On-Board
Reference
7 VDD V|t V|n- | TEST POINT PC COMPACT SMT | Keystone Electronics® 5016
GND SCL SDA
VDD
Note: The components listed in this Bill of Materials are representative of the PCB assembly. The

released BOM used in manufacturing uses all RoHS-compliant components.
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Germany - Munich
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